Лабораторная работа №01 по дисциплине "Информатика и программирование модуль 2"

ТЕМА: Знакомство со средой программирования и ее настройка.

----  Создание консольного приложения.

Алфавит языка программирования Delphi (Object Pascal). Идентификаторы.

Переменные и константы. Типы данных. Описание (объявление) переменных.

Операции. Стандартные функции. Выражения.

Оператор (инструкция) присваивания.

Операторы (инструкции) ввода и вывода в режиме консольного приложения.
Форматы вывода.
Комментарии. Создание простейших программ.

СОЗДАНИЕ И ИСПОЛЬЗОВАНИЕ ПАПОК И СОХРАНЕНИЕ ФАЙЛОВ
--------------------------------------------------
1. На жестком диске, указанном преподавателем, 
создайте папку с именем, совпадающим с номером Вашей группы, 
затем в этой папке создайте еще одну папку 
с именем (на русском языке с БОЛЬШОЙ буквы), совпадающим 
с Вашей фамилией (далее эта папка будет называться Вашей папкой).

2. В Вашей папке создайте папку с именем ИП2З_лр01, 
совпадающим с именем файла с этим заданием.

3. При выполнении задания создавайте в папке ИП2З_лр01 для каждой программы 
папку с именем, по смыслу соответствующим действиям, выполняемым составляемой программой, или, по крайней мере, соответствующим номеру программы в ней (например, с именем 1_2 и т.п.), 
и сохраняйте все файлы, имеющие отношение к этой программе, 
в этой созданной папке. 
Имена сохраняемых файлов должны отличаться от имен, присваиваемых 
по умолчанию (Project1, Unit1 и т.п.), и должны по смыслу соответствовать действиям, выполняемым составляемой программой, или, по крайней мере, соответствовать номеру лабораторной работы и номеру программы в ней, например, Pr_1_2 и т.п., 
причем буквы в именах этих файлов должны быть только латинские.

4. ПРИ ВЫПОЛНЕНИИ СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ ПРИ СОЗДАНИИ ПАПОК 
И СОХРАНЕНИИ ФАЙЛОВ ДЕЙСТВУЙТЕ АНАЛОГИЧНО ПУНКТАМ 2 И 3 ЭТОЙ РАБОТЫ.

5. ВНИМАНИЕ! Для возможности работы с программой Turbo Delphi пользователя 
          (например, с именем user) 
          в пользовательской папке этого пользователя 
          (для операционной системы Windows XP, например, 
          в папке C:\Documents and Settings\user) 
          обязательно должен находиться регистрационный файл reg736.txt, 
          который может быть скопирован туда
          из папки с лабораторными работами.
ЗНАКОМСТВО СО СРЕДОЙ ПРОГРАММИРОВАНИЯ
-------------------------------------

6. Запустите программу Turbo Delphi 
"Пуск => Все программы => Borland Developer Studio 2006 => Turbo Delphi" (ЗАПУСК ПРОГРАММЫ МОЖЕТ ПРОИСХОДИТЬ ОЧЕНЬ ДОЛГО).

7. После запуска выполните команды меню окна Turbo Delphi 
    "View => Toolbars => Customize..." 
или команду "Customize..." из контекстного меню 
    для области панелей инструментов (или для строки меню окна Turbo Delphi) 
и затем, после появления на экране окна "Customize" 
(в этом окне смотрите вкладку "Commands", категорию "Edit"), 
перетащите кнопки 
"Separator", "Undo", "Redo", "Separator", "Cut", "Copy", "Paste" 
в перечисленном порядке из окна "Customize" 
на правую часть панели инструментов "Standard".

КОНСОЛЬНЫЕ ПРИЛОЖЕНИЯ
---------------------

8. Для перехода к созданию консольного приложения в окне Turbo Delphi 
    (обычно в правом нижнем углу этого окна) 
    во внутреннем окне "Tool Palette" (на вкладке "Delphi Projects") 
    выберите строку "Console Application"
    (можно двойным "щелчком" левой кнопки "мыши") 
или выполните команды меню окна Turbo Delphi "File => New => Other..." 
    (или нажмите на панели инструментов "Standard" кнопку "New items") 
и затем в появившемся окне "New Items" в категории "Delphi Projects" 
выберите значок "Console Application", 
после чего на экране должно появиться окно проекта создаваемого приложения.

9. Выполните действия, связанные с сохранением файлов создаваемой программы 
с именем DIVMOD (в соответствии с требованиями пункта 3) c использованием одной из команд сохранения из меню команды "File" окна Turbo Delphi 
(например, "File => Save Project As...").

   ПРОГРАММА 1-1 
   -------------
10. Измените текст программы в окне проекта так, чтобы он выглядел, как указано 
   ниже (здесь текст DIVMOD после слова program вводить не надо – 
   он должен появиться после сохранения файлов в соответствии с пунктом 9):

   [image: image1.png]E DIVMOD. bdsproj

- Cprogram DIVHOD;

(§APPTYPE CONSOLE}

SysUtils;
var a,b,d,m: integer;
- Chbegin
{ TODO -oUser -cConsole Main : Insert code here )
10| readln (aB):
di=a div b; //fenaz vacTs or zexemuz
mi=a mod b: //Ocravor or zememiz
writelnfa,' ',b,' div ',d,' wod ',m);
writeln;
readin;
end.

Insert Modied Code  Hstory.





11. При выполнении созданного консольного приложения будет происходить ввод 
двух целых чисел, вычисление и вывод на экран в одной строке введенных чисел, а также целой части от деления и остатка от деления первого числа на второе 
с поясняющими текстами в виде названий операций div и mod 
(если второе из вводимых чисел будет равно нулю, то произойдет аварийное завершение работы программы).
12. Запустите созданную программу в среде программирования Turbo Delphi 
(для чего можно нажать на кнопку "Run" на панели инструментов "Debug" или нажать клавишу F9 на клавиатуре) и проверьте правильность ее выполнения в соответствии с теми действиями, которые она должна выполнять 
(для данной программы – в соответствии с пунктом 11). 
После запуска программы в папке с сохраненными файлами программы также появится выполняемый файл этой программы с расширением "exe".

13. Запустите созданную программу независимо от среды программирования, для чего можно открыть папку, в которой были сохранены файлы созданной программы, и запустить выполняемый файл (с расширением "exe").

АЛФАВИТ ЯЗЫКА ПРОГРАММИРОВАНИЯ 
------------------------------

14. В алфавит языка программирования входят: 
цифры 0 1 2 3 4 5 6 7 8 9; 
большие и маленькие латинские буквы 
                     A B C D E F G H I J K L M N O P R S T U V W X Y Z 
                     a b c d e f g h i j k l m n o p r s t u v w x y z 
          и символ подчеркивания _; 
специальные символы + - * / = , . : ; ' < > ( ) [ ] { } ^ @ $ # 
                    и символ "пробел". 
Символ ; используется при записи программы для разделения операторов, 
объявлений и описаний.

ИДЕНТИФИКАТОРЫ 
--------------

15. Идентификаторы предназначены для обозначения переменных, процедур, функций и других объектов в программе, включая имя программы в строке с program. 
Идентификатор может состоять из букв, цифр и символов подчеркивания _, 
но начинаться он должен только с буквы или символа подчеркивания _.
Большие и маленькие буквы в идентификаторах не различаются. 
Между двумя идентификаторами в программе должен быть хотя бы один 
разделитель (пробел, символ конца строки, комментарий или другой специальный 
             символ или комбинация специальных символов). 
Идентификаторы различаются по их первым 63 символам. 
Каждый объект программы, в том числе и ее имя, должен иметь 
уникальный идентификатор.
16. Примеры идентификаторов: a  A  x  bc  ff  vv1  v_W  summa  DELTA2  alfa5

ПЕРЕМЕННЫЕ И КОНСТАНТЫ 
----------------------

17. Переменная – это область памяти, которая отводится для данных, используемых 
             программой.
Переменная в программе обозначается идентификатором.
Константа – это целое или дробное число, строка символов или отдельный 
            символ.

18. Примеры констант: числовых – 123 0.1 0.0 –5.03 0 1 1500 1.5e3 1.5E3
                  символьных – '***Result: ' 's='
ТИПЫ ДАННЫХ 
-----------

19. Пока будем использовать следующие идентификаторы для обозначения типов 
и соответствующие типы данных: 
integer – целый тип; 
real    – вещественный тип; 
string  – строковый тип.

ОПИСАНИЕ (ОБЪЯВЛЕНИЕ) ПЕРЕМЕННЫХ 
--------------------------------

20. Описание (объявление) переменных начинается с ключевого слова var 
и обязательно должно предшествовать использованию этих переменных 
в программе.

21. Примеры описания (объявления) переменных: 
var s,i: integer; 
    x,y: real; 
    st: string;
ОПЕРАЦИИ 
--------

22. Математические операции:

	Операция
	Действие
	Типы операндов
	Тип результата
	Приоритет

	+
	Сложение
	Хотя бы один из операндов real
	real
	Более низкий

	
	
	Оба операнда integer
	integer
	

	-
	Вычитание
	Те же, что для +
	Тот же, что для +
	

	*
	Умножение
	Те же, что для +
	Тот же, что для +
	Более высокий

	/
	Деление
	real или integer
	real
	

	div
	Деление нацело
	integer
	integer
	

	mod
	Остаток от деления
	
	
	


СТАНДАРТНЫЕ ФУНКЦИИ 
-------------------

23. Некоторые математические функции:

	Функция
	Описание
	Тип

	
	
	аргумента
	результата

	abs(x)
	Абсолютное значение x 
(или (x()
	real
integer
	real

integer

	sqrt(x)
	Квадратный корень из x 
(или x1/2, или x0,5)
	real

integer
	real

	sqr(x)
	Квадрат x (x2)
	real

integer
	real

integer

	sin(x)
	Синус x
	real

integer
	real

	cos(x)
	Косинус x 
	real

integer
	real

	arctan(x)
	Арктангенс x
	real

integer
	real

	pi
	Число (
	–
	real

	exp(x)
	Экспонента x (или ex)
	real

integer
	real

	ln(x)
	Натуральный логарифм x
	real

integer
	real


24. Некоторые функции преобразования:

	Функция
	Описание
	Тип

	
	
	аргумента
	результата

	int(x)
	Целая часть x
	real
	real

	frac(x)
	Дробная часть x
	real
	real

	trunc(x)
	Отбрасывает дробную часть x
	real
	integer

	round(x)
	Округление x 
до ближайшего целого числа
по общепринятым правилам
	real
	integer


ВЫРАЖЕНИЯ 
---------

25. Для вычисления значений по формулам применяются выражения, состоящие из 
операндов (переменных, констант, функций), связанных между собой знаками 
математических операций. 
При записи выражений можно не ставить пробел между операндами и знаками 
операций (за исключением операций div и mod). 
При вычислении значений выражений в первую очередь вычисляются значения 
функций, затем операции умножения и деления, затем операции сложения и 
вычитания. 
Порядок действий в выражениях может быть изменен с помощью круглых скобок, 
при этом операции в скобках будут выполняться в обычном порядке, но раньше, 
чем операции за скобками. 
При записи выражений, содержащих скобки, число открывающих скобок должно 
быть равно числу закрывающих скобок. 
Тип выражения определяется типами входящих в него операндов и выполняемыми 
в нем операциями.

26. Примеры выражений: 
x+1 
y+sin(abs(x)*pi/180)-1 
I mod 2+l 
-x+y/z 
(a-b)/(c+d/(e+f))

ОПЕРАТОР (ИНСТРУКЦИЯ) ПРИСВАИВАНИЯ 
----------------------------------

27. Примеры оператора присваивания: 
z:=x+1; 
f:=y+sin(abs(x)*pi/180)-1; 
k:=I mod 2+l; 
uu := -x+y/z1z2; 
t:=(a-b)/(c+d/(e+f)); 
s:=s+1;

28. При выполнении оператора присваивания сначала вычисляется значение выражения 
справа от знака присваивания ":=" и затем результат присваивается переменной 
слева от знака ":=". Переменная и выражение должны иметь совместимые типы 
(например, real и integer, но не наоборот). 
Пробелы внутри знака присваивания недопустимы.

ОПЕРАТОРЫ (ИНСТРУКЦИИ) ВВОДА И ВЫВОДА В РЕЖИМЕ КОНСОЛЬНОГО ПРИЛОЖЕНИЯ 
---------------------------------------------------------------------
29. При выполнении, например, оператора ввода readln(x1,x2,x3) программа ждет, 
пока на клавиатуре будут набраны три числа, разделенные пробелом, табуляцией 
или нажатиями клавиши Enter, и затем, после ввода последнего из этих чисел 
и нажатия на клавишу Enter,введенные значения присваиваются переменным, имена 
которых указаны в операторе ввода. 
Если было введено больше чисел, чем указано переменных в операторе ввода, то 
остальные числа будут утеряны. 
Для того чтобы окно с результатами выполнения консольного приложения 
неожиданно не исчезло с экрана, рекомендуется в конце программы использовать 
оператор readln без аргументов (этот оператор будет ждать нажатия на клавишу 
Enter). 
Во избежание недоразумений при вводе данных не рекомендуется использовать 
оператор read, который передает излишне введенные данные следующему 
оператору ввода.

30. При выполнении, например, оператора write('*Results: ',s,' ',i,' ',j,' ',k), 
на экран будут выведены в одной строке текст *Results: и значения переменных 
s,i,j,k, разделенные пробелами, после чего курсор останется в этой же строке 
после последнего выведенного символа значения переменной k. 
В операторе write можно использовать выражения, например, 
write(I mod 2+l,'  Argument ',x,y+sin(abs(x)*pi/180)-1). 
Оператор writeln, в отличие от оператора write, после вывода значений 
выполняет переход (перевод курсора) в начало следующей строки. 
Оператор writeln без аргументов выполняет переход в начало следующей строки.

ФОРМАТЫ ВЫВОДА 
--------------

31. Пример форматов вывода: 
writeln(aa:5, b:8:2); 
После имени переменной aa через двоеточие указана одна спецификация, означающая количество позиций, отводимых для вывода значения этой переменной, причем внутри этих позиций значение выравнивается по правому краю. 
Для переменной b указаны две спецификации, означающие, что под значение этой переменной отводится 8 позиций, причем 2 из них – под дробную часть (одну из 8 позиций занимает десятичный разделитель целой и дробной частей числа). 
Две спецификации можно указывать только для вещественных величин. 
Спецификации могут быть выражениями целого типа.

КОММЕНТАРИИ 
-----------

32. Комментарий – это пояснительный текст, который можно записывать в любом 
месте программы, где разрешен пробел. Наличие или отсутствие комментариев 
никак не влияет на работу программы. 
Текст комментария может быть ограничен символами { и } или их эквивалентами 
(* и *) и может содержать любые символы, включая русские буквы. Комментарий, 
ограниченный указанными символами, может размещаться в нескольких строках. 
Однострочный комментарий должен содержать символы // в начале места 
расположения комментария в строке.

33. Примеры комментариев: 
{ Ниже находится оператор, 
  увеличивающий значение s на 1 } 
s:=s+1; // Здесь значение s увеличивается на 1 
// Ниже находится еще один комментарий 
(* Выше находится оператор, увеличивающий значение s на 1 *)

ПРИМЕР ТЕКСТА ПРОГРАММЫ 
-----------------------

34. Текст программы 

program Primer;

{$APPTYPE CONSOLE}

uses
  SysUtils;

var a,b,d: integer; // Объявление переменных
    x,y: real;

begin
  { TODO -oUser -cConsole Main : Insert code here }

  readln(a,b); { Ввод чисел }

  d:=a div b;  // Целая часть от деления
  writeln(a:5,' ',b:5,' ','div ',d); (* Вывод результатов*)
  readln(x); // Ввод x

  y:=sin(abs(x)*pi/180)-1; //Вычисление y
  writeln(x:8:2,' ',abs(x)*pi:10:2,' ',y); { Вывод x,

                                    произведения модуля x на число "пи",

                                    y}

  readln; //Ожидание нажатия на клавишу Enter
end.
СОЗДАНИЕ ПРОСТЕЙШИХ ПРОГРАММ 
----------------------------
35.ПЕРЕД НАЧАЛОМ СОСТАВЛЕНИЯ КАЖДОЙ ОЧЕРЕДНОЙ ПРОГРАММЫ (ПРИ ВЫПОЛНЕНИИ ЭТОЙ 
И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ) ДЕЙСТВУЙТЕ АНАЛОГИЧНО ПУНКТУ 3 ЭТОЙ РАБОТЫ.

   ПРОГРАММА 1-2 
   -------------

36. Создайте консольное приложение, при выполнении которого происходит: 
а) вывод текста "X= " и затем ввод в этой же строке вещественного аргумента x; 
б) вычисление значения abs(x) функции abs от введенного аргумента x 
   с выводом в отдельной строке слева направо
   названия функции abs, двух пробелов и вычисленного значения функции abs(x) 
   с использованием формата вывода с отведением для выводимого значения 
   10 позиций, 2 из которых – под дробную часть этого значения; 
в) действия предыдущего подпункта б) для функций 
   sqrt, sqr, sin, cos, arctan, exp, ln, int, frac, trunc, round, 
   причем для функций sqrt и ln следует вычислять значения 
                      sqrt(abs(x))и ln(abs(x)), 
          для выводимых целочисленных значений trunc(x) и round(x) должен быть 
              формат вывода с отведением только 10 позиций (без дробной части);
г) в тексте программы перед строками с соответствующими операторами должны быть 
   вставлены строки с комментариями "Математические функции" 
   и "Функции преобразования".

37. ПОСЛЕ СОСТАВЛЕНИЯ КАЖДОЙ ОЧЕРЕДНОЙ ПРОГРАММЫ (ПРИ ВЫПОЛНЕНИИ ЭТОЙ 
И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ) ДЕЙСТВУЙТЕ АНАЛОГИЧНО ПУНКТАМ 12 И 13 
ЭТОЙ РАБОТЫ.

   ПРОГРАММА 1-3 
   -------------

38. Создайте консольное приложение, при выполнении которого происходит:

а) ввод трех вещественных чисел X, Y и Z;

б) вычисление и вывод в отдельной строке результата вычислений по формуле

       SIN(X((/180) 
   S = ————————————— ( e-ABS(Y+Z). 
         Y2 + Z2
ОТЧЕТ О ВЫПОЛНЕНИИ РАБОТЫ, ЕСЛИ БЫ ПРИСУТСТВОВАЛ ПРЕПОДАВАТЕЛЬ 
--------------------------------------------------------------
39. Продемонстрируйте тексты всех созданных программ, а также их выполнение 
в среде программирования и независимо от нее.

________________________________________________________________________________

